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Основы измерений параметров
ВЧ усилителей с помощью
анализатора цепей E5072A серии ENA

Рекомендации по применению

Введение

ВЧ усилитель мощности является основным компонентом 
устройств беспроводной связи, медицинского оборудования, 
аэрокосмических и оборонных систем. При проведении 
научных исследований и производственного тестирования 
необходимо с высокой точностью определять основные 
характеристики усилителей, поскольку они должны 
соответствовать строгим требованиям, предъявляемым к 
проектируемым системам.
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Данный документ рассказывает, как с помощью простой схемы с 
векторным анализатором цепей (VNA) можно измерять основные 
характеристики усилителя, такие как S-параметры, К-фактор, 
компрессия усиления и нелинейные искажения, а также выпол-
нять импульсные измерения. Кроме того, приводятся методики 
измерений с применением анализатора цепей E5072A серии ENA1 
и пошаговые инструкции для определения типовых 
характеристик усилителя.

1. Подробная информация об анализаторе цепей E5072A серии ENA приведена в 
техническом обзоре, номер документа 5990-8004EN.
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Рис. 1. Внутренние аттенюаторы источника для схем без развязки по питанию.

S-параметры / Коэффициент стабильности
Измерения S-параметров, учитывающих отражение и передачу 
сигналов, обычно выполняются с помощью векторных анализаторов 
цепей. Наряду с основными S-параметрами устройств, разработчики 
и производители должны внимательно изучать другие параметры, 
вычисленные на основе S-параметров. Одним из таких параметров 
является K-фактор, представляющий особый интерес для разработчиков 
усилителей. Он вычисляется на основе всех S-параметров двухпортовых 
устройств (от S

11
 до S

22
) и характеризует стабильность (устойчивость 

к самовозбуждению) усилителей. Если K-фактор больше 1 при дельте 
(Δ), меньшей 1, то усилитель безусловно стабилен и не генерирует 
колебания при любой нагрузке.

K-фактор вычисляется на основе всех четырех S-параметров 
тестируемых устройств (ТУ), поэтому для высокоточных измерений 
необходима полная двухпортовая калибровка. При этом важно 
измерять S-параметры с высокой точностью.
Чтобы защитить приемники векторного анализатора цепей от 
повреждения, измерения усилителей с высоким коэффициентом 
усиления часто выполняются с использованием внешнего аттенюатора, 
установленного на выходе сигнала, что приводит к сужению динами-
ческого диапазона системы при определении параметра S12 или S22 
(обратные измерения). Анализатор E5072A имеет два встроенных 
аттенюатора, по одному на каждом порте, чтобы независимо изменять 
ослабление на портах 1 и 2 в схеме без развязки по питанию. 
Используя такую схему, можно установить очень небольшой сигнал 
источника от порта 1 и исключить допол- нительный внешний 
аттенюатор на порте 2, что позволяет расширить динамический диапазон 
и повысить точность обратных измерений и, следовательно, точность 
вычисления К-фактора. На блок-схеме анализатора E5072A (рис.1) 
показаны независимые аттенюаторы для схемы без развязки по пита-
нию. Требуемый уровень мощности на каждом порте устанавливается 
при настройке соответствующего внутреннего аттенюатора порта.

R1

A

R2

B

Усилитель с высоким коэффициентом усиления

–85 дБм 0 дБм

ATT = 40 Дб
(Порт 1)

ATT = 0 Дб
(Порт 2)

Определение характеристик ВЧ усилителей –
измерение параметров
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Рис. 2. Вычисление K-фактора с использованием редактора уравнений.

С помощью редактора уравнений в анализаторе E5072A пользователи 
могут вводить определенные уравнения или параметры, такие как 
K-фактор или p-фактор. Результат математических вычислений, 
выполненных на основе измеренных трасс, отображается в реальном 
времени. Уравнение может быть составлено на основе любой 
комбинации существующих трасс, параметров или констант (рис. 2).

Далее будет описана последовательность измерения K-фактора с 
помощью схемы без развязки по питанию и анализатора E5072A. В 
квадратных скобках показаны [кнопки передней панели], а жирным 
шрифтом представлены программные клавиши. В круглых скобках
указаны (значения параметров), например, (0 дБм)

Шаг 1 Настройка параметров тестового сигнала

Перед калибровкой и измерениями необходимо ввести параметры 
тестового сигнала, например, частоту, полосу фильтра ПЧ (IFBW) и 
число точек (NOP). Порты 1 и 2 не развязаны по питанию, для них 
можно установить разные уровни мощности.

[Sweep Setup] > Power > Port Pwr Couple (ВЫКЛ)
[Sweep Setup] > Power > Port Pwr & Att > Port 1 Pwr & ATT 
(например, -60 дБм)
[Sweep Setup] > Power > Port Pwr & Att > Port 2 Pwr & ATT 
(например, 0 дБм)
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На рис. 3 показано сравнение результатов измерений, полученных 
при использовании схемыс развязкой и без развязки по питанию 
для портов 1 и 2. Используя схему без развязки по питанию, можно 
вычислять K-фактор при меньшем шуме трассы.

Рис. 3. Сравнение результатов измерений, полученных с использованием 
схемы с развязкой по питанию (справа) и без развязки по питанию (слева).

Шаг 2 Калибровка

Полная двухпортовая калибровка, необходимая для измерений, 
выполняется при нажатии кнопки [Cal] анализатора E5072A.

Шаг 3 Настройка редактора уравнений

Для вычисления K-фактора с помощью редактора уравнений можно 
выбрать любые трассы. Следует включить редактор уравнений, чтобы 
показать вычисленный К-фактор для выбранной трассы.

[Display] > Equation Editor

В окошке «Functions/Constant» (Функции/Константы) выбрать «ad-
vanced-math» и ввести уравнение
«K-factor = kfac(S11, S12, S21, S22)» или «K-factor = kfac(1,2)» 
Поставить галочку в поле «Equation», чтобы разрешить ввод 
уравнения. В качестве формата трассы для К-фактора выбрана 
Линейная Амплитуда (Lin Mag):
[Format] > Lin Mag

S12

K-фактор

S12

K-фактор
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Полная двухпортовая калибровка для измерений 
усилителя высокой мощности

Разработчики усилителей уделяют большое внимание их 
стабильности при работе с сигналами как низкой, так и высокой 
мощности. Чтобы гарантировать стабильную работу усилителя
в реальных условиях, необходимо контролировать стабильность 
сигналов высокой и низкой мощности. Если выходная мощность ТУ 
превышает уровень компрессии или уровень повреждения внутренних 
приемников анализатора, то для защиты приемников на выходном 
порте следует использовать аттенюаторы с большим коэффициентом 
ослабления. Большое ослабление приводит к уменьшению отношения 
сигнал/шум при выполнении обратных измерений (таких параметров, 
как S

12
 или S

22
) с использованием полной 2-портовой калибровки. 

При измерении отражения на выходном порте ТУ (S
22

 = B/R2), сигнал 
источника с порта 2 анализатора ослабляется, а отраженный тести-
руемым устройством сигнал повторно ослабляется перед попаданием 
в приемник В. Это приводит к значительному снижению точности 
измерений. Схема измерения показана на рис. 4.
Для повышения точности в анализаторе E5072A используется 
конфигурируемая схема измерений, обеспечивающая доступ к сиг-
нальным цепям между внутренним источником, приемниками, мостами и 
тестовыми портами анализатора. В альтернативной схеме измерений
(рис. 5) используется прямой доступ к приемнику. При измерении 
параметра S

21
 (= B/R1) выходной сигнал ТУ измеряется в приемнике 

В через внешний ответвитель, а ослабление для защиты приемника 
можно выбрать и внести в тракт приемника. Вентили с малыми потеря-
ми в одном направлении ослабляют сигнал на порте 2 для защиты 
анализатора от повреждения при высокой мощности на входе. При 
измерении S

12
 (= A/R2) или S

22
 (= B/R2), отношение сигнал/шум можно 

увеличить с помощью вентилей с малыми потерями, введенными 
в тракт источника от порта 2, по сравнению со схемой измерений 
с большим ослаблением (рис. 4). С помощью такой схемы можно 
повысить точность измерений S

12
 и S

22
.

Рис. 4. Результат измерения усилителя высокой мощности с 
использованием типовой схемы измерений с большим ослаблением

Рис. 5. Результат измерения усилителя мощности с использованием 
схемы измерений с прямым доступом к приемнику.

S11 S12

S21 S22

S11 S12

S21 S22
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Уровни мощности, измеренные с использованием обеих схем, показаны 
на рис. 6. Сравниваются результаты измерений усилителя высокой мощности 
(+30 дБм). В типовой схеме измерений с большим ослаблением (слева), 
уровень входной мощности приемника В для обратных измерений снижа-
ется до -86 дБм из-за большого ослабления на выходе ТУ. Такой низкий 
уровень мощности приводит к снижению точности обратных измерений. 
Уровень входной мощности можно оптимизировать (например, до -50 дБм), 
подбирая соответствующие компоненты в схеме измерения с прямым 
доступом к приемнику (справа). Повышение уровня мощности, подаваемой 
на ТУ при обратных измерениях, приводит к увеличению отношения
сигнал/шум и возрастанию точности измерений S12 и S22.

Рис. 6. Сравнение уровней мощности в схеме измерений с большим ослаблением (слева) и в схеме измерений 
с прямым доступом к приемнику (справа).
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Контроль выходной мощности источника для учета 
изменений коэффициента усиления

Настройка и определение характеристик некоторых усилителей 
мощности выполняются в режиме насыщения. Выходной уровень 
в заданной полосе частот должен иметь требуемое постоянное 
значение с допустимым отклонением, меньшим 0,1 дБ. Поскольку 
коэффициент усиления усилителя изменяется в определенной полосе 
частот, то для учета этих измерений при определении характеристик 
устройства необходим внешний контроль выходной мощности.

Тестирование такого типа выполняется с использованием 
генератора сигналов, датчика мощности и анализатора спектра. На 
рис. 7 показана простая схема измерения. Выходная мощность ТУ 
контролируется датчиком мощности через ответвитель, а мощность 
генератора сигналов регулируется до получения требуемого уровня 
мощности на выходе ТУ. Поскольку такая последовательность контроля 
мощности требует, чтобы все контрольно-измерительные приборы 
работали под управлением системного контроллера, а измерения были 
синхронизированы для каждой точки данных, то общее время измере-
ний увеличивается. Стоимость такой системы тестирования высока, 
поскольку в ней используется несколько приборов, нуждающихся в 
калибровке.

Рис. 7. Обычная схема измерения с контролем мощности.

Анализатор спектра
Генератор сигналов

Датчик
мощности

Системный контроллер

ответвитель

Регулировка мощности
источника

ТУ
P

вх. P
вых.

например, GPIB
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Чтобы повысить точность измерений, можно отказаться от схемы с 
несколькими приборами и воспользоваться анализатором E5072A, 
который имеет функции калибровки мощности. А его функция вырав-
нивания уровня по приемнику позволяет ускорить установку уровней 
входной или выходной мощности тестируемого устройства во время 
измерений. Эти полезные функции анализатора E5072A упрощают 
схему измерения.

1. Калибровка мощности

Для определения характеристик усилителя при конкретном значении 
входной мощности, перед измерениями необходимо выполнить 
калибровку мощности с использованием измерителя/датчика 
мощности, подключенного к анализатору E5072A. Уровень выходной 
мощности на тестовом порте анализатора E5072A автоматически 
регулируется для получения требуемого уровня мощности в 
плоскости калибровки (обычно это интерфейс тестируемого 
устройства). Точность калибровки мощности определяется точностью 
датчика мощности, подключенного к источнику анализатора E5072A, 
и позволяет устанавливать уровень мощности на входе ТУ
с погрешностью менее 0,1 дБ.

2. Калибровка приемника

Калибровка приемника необходима для абсолютного измерения 
мощности (в дБм) с помощью приемников анализатора E5072A. При 
калибровке математически удаляется зависимость уровня сигнала от 
частоты в тракте приемника, а показания анализатора E5072A
регулируются в соответствии с заданным уровнем, полученным при 
калибровке мощности.Откалибровав приемник, можно выполнять 
точные абсолютные измерения мощности (в дБм) с помощью анали-
затора E5072A для контроля входной или выходной мощности 
тестируемого устройства.

3. Выравнивание уровня по приемнику

Анализатор E5072A имеет функцию выравнивания уровня по 
приемнику, позволяющую регулировать уровень мощности источника 
при свипировании по частоте или мощности. Перед каждым 
свипированием выполняется изменяемое число фоновых циклов 
свипирования для многократного измерения мощности на входе 
приемника. Такие измерения часто используются для регулировки 
уровня мощности источника анализатора E5072A, чтобы получить
требуемую мощность на интерфейсе тестируемого устройства. 
Функция выравнивания уровня по приемнику позволяет ускорить 
и повысить точность измерения уровня мощности по сравнению 
с обычными методами, основанными на применении измерителя 
мощности и датчика мощности.

Методы калибровки мощности, имеющиеся в анализаторе E5072A, 
позволяют упростить системы тестирования, предназначенные для 
измерения параметров усилителей.
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Процесс измерения разбит на следующие шаги:
Шаг 1 Настройка параметров тестового сигнала
Шаг 2 Калибровка мощности
Шаг 3 Калибровка приемника
Шаг 4 Калибровка с помощью калибровочных мер
Шаг 5 Выравнивание уровня по приемнику

Шаг 1 Настройка параметров тестового сигнала

Перед калибровкой и измерениями следует ввести параметры тестового 
сигнала, такие как частота, полоса фильтра ПЧ (IFBW) и число точек 
(NOP). Трассы 1, 2 или 3 соответственно предназначены для измерения 
зависимости от частоты следующих параметров – коэффициент усиле-
ния, уровень входной и выходной мощности ТУ. Абсолютное измерение 
входной мощности выполняется с помощью внутреннего приемника 
R1 порта 1 анализатора E5072A, а выходной мощности – с помощью 
приемника В порта 2.

[Display] > Num Trace (3)
[Display] > Allocate Trace (x3)
Активировать трассу 1 и нажать[Meas] > S21, [Format] > Log Mag
Активировать трассу 2 и нажать [Meas] > S21, [Format] > Phase
Активировать трассу 3 и нажать [Meas] > Absolute > R1 (1)
Активировать трассу 4 и нажать [Meas] > Absolute > B (1)

Ниже приведены пошаговые инструкции для измерения зависимости 
коэффициента усиления усилителя от частоты при контролируемой вы-
ходной мощности с использованием методов калибровки мощности, реа-
лизованных в анализаторе E5072A. Схема измерений показана на рис. 8. 
Перед портом 2 требуется установить дополнительный аттенюатор, ослаб-
ляющий выходной сигнал ТУ для защиты внутренних приемников анали-
затора. Подробная информация о функции регулировки мощности анали-
затора E5072A приведена в приложении А «Предельно допустимая мощность».

Рис. 8. Схема измерения коэффициента усиления.

ТУ

Порт1 Порт2 

P
вх. P

вых.

Аттенюатор
(опционально)
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Рис. 9. Калибровка мощности с использованием датчика мощности.

Порт1 Порт2 

Датчик мощности 
(например Keysight серии U2000)

подключенный к анализатору E5072A

P
вх.

Шаг 2 Калибровка мощности

Калибровка с подключенным датчиком мощности позволяет повысить 
точность измерения уровня мощности в плоскости калибровки (вход 
ТУ). USB датчик мощности Agilent серии U2000 можно непосредственно 
подсоединять к USB порту анализатора E5072A, а процедурой калибровки 
можно управлять с помощью встроенного ПО анализатора E5072A (рис. 9).

(1) Подключить измеритель/датчик мощности к анализатору E5072A.

(2) Настроить датчик мощности. (Ниже приведены инструкции 
 для калибровки с помощью USB-датчика мощности.) 
 [System] > Misc Setup > Power Meter Setup > Select Type (USB)
 [System] > Misc Setup > Power Meter Setup > USB

(3) Установить требуемый уровень мощности. 
 Требуемый уровень для калибровки мощности установлен. Уровень
 мощности в плоскости калибровки отрегулирован
 [Sweep Setup] > Power (например, -10 дБм)

(4) Установить допустимое отклонение (Tolerance) и максимальное
 число итераций (Iteration)для калибровки мощности. Свипирующие
 измерения при калибровке мощности выполняются до получения 
 в плоскости калибровки требуемого уровня мощности с допустимой
 точностью. Установив максимальное число итераций, вы зададите 
 максимальное число свипирований для калибровки мощности 
 с заданной точностью
 [Cal] > Power Calibration > Tolerance (например, 0,05 дБ)
 [Cal] > Power Calibration > Max Iteration (например, 10)

(5) Запустить калибровку мощности.
 [Cal] > Power Calibration > Take Cal Sweep
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Шаг 3 Калибровка приемника

Калибровка приемника выполняется перед выравниванием уровня 
по приемнику. Калибровкапозволяет математически удалить зависи-
мости потерь в тракте приемника (такие как потери в кабеле, аттенюа-
торе) от частоты. При этом отображается величина в дБм, полученная 
в результате абсолютных измерений мощности в плоскости калибровки 
с помощью анализатора E5072A. После выполнения калибровки с 
использованием меры «сквозное соединение» между портом 1 с кали-
брованной мощностью источника и портом 2 приемника (рис. 10),
отображается уровень мощности в дБм в плоскости калибровки.
Если в качестве трассы измерения выбрать «B (1)» (абсолютное 
значение на входе приемника В при выборе порта 1 в качестве источника), 
то выходную мощность тестируемого устройства в дБм можно контроли-
ровать с помощью свипирующих измерений, выполняемых анали-
затором E5072A. При калибровке приемника R1 входная мощность 
тестируемого устройства отображается трассой «R1 (1)».

(1)  Выбрать источник и порт приемника для калибровки.
 [Cal] > Receiver Calibration > Select Receiver > R1 & B
 [Cal] > Receiver Calibration > Source Port (1)
 [Cal] > Receiver Calibration > Power Offset (0 дБ)

(2) Выполнить калибровку приемника.
 [Cal] > Receiver Calibration > Calibrate

Рис. 10. Калибровка приемника.

R1 B

Калибровачная мера «Сквозное соединение»

Порт1 Порт2 

Аттенюатор
(дополнительный)
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Рис. 11. Калибровка с использованием калибровочных мер.

Шаг 4 Калибровка с помощью калибровочных мер

Выполните калибровку с использованием калибровочной меры 
«сквозное соединение». Для точного измерения комплексного 
коэффициента отражения от входа (S11) потребуется расширенная 
калибровка с использованием калибровочных мер «холостой ход», 
«короткое замыкание» и «согласованная нагрузка» (рис. 11).

Аттенюатор
(дополнительный)

R1 B
Порт1 Порт2 

Калибровачная мера «Сквозное соединение»

Калибровачные меры «Холостой ход»,
«Короткое замыкание»/
«Согласующая нагрузка» (Доп.)
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Рис. 12. Зависимость коэффициента усиления от частоты с контролируемой входной мощностью (слева) 
и контролируемой выходной мощностью (справа).

Шаг 5 Выравнивание уровня по приемнику

Функция выравнивания уровня по приемнику используется для 
получения требуемого уровня мощности в плоскости калибровки. 
Свипирование выполняется в каждой точке данных тестового сигнала, 
отклонение от требуемого уровня мощности используется для корре-
кции уровня мощности источника. Если для выравнивания уровня 
выбран приемник В, то уровень выходной мощности тестируемого 
устройства регулируется с заданным значением отклонения или
свипирование выполняется до достижения заданного числа итераций.

(1) Выбрать приемник для выравнивания уровня.
 [Sweep Setup] > Power > Receiver Leveling > Port 1 > Receiver > B

(2) Установить значение отклонения и максимальное число итераций.
 [Sweep Setup] > Power > Receiver Leveling > Port 1 > Tolerance (например, 0,1 дБ)
 [Sweep Setup] > Power > Receiver Leveling > Port 1 > Max Iteration (например, 10)
(3) Включить функцию выравнивания уровня по приемнику для порта 1.
 [Sweep Setup] > Power > Receiver Leveling > Port 1 > Leveling > ON

На рис.12 показан коэффициент усиления ВЧ усилителя с мощностью, 
контролируемой на уровне -10 дБм. Входная мощность (P

вх.
) и выходная 

мощность (Pвых.) тестируемого устройства контролируются одновременно в 
процессе свипирования. Выравнивание уровня по приемнику В уменьшает 
изменения выходной мощности, обусловленные непосредственно изменени-
ями коэффициента усиления усилителя, и обеспечивает обратную связь для 
коррекции мощности источника анализатора E5072A. В результате можно 
получить более плоскую кривую зависимости выходной мощности от частоты 
в диапазоне частот измерения.

Коэффициент усиления (S21) Коэффициент усиления(S21)

Рвх. РвыхР
вых.

Р
вх.

Опорный сигнал = -10дБм,
0,1 дБм/дел.

Опорный сигнал = -10дБм,
0,1 дБм/дел.
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Компрессия усиления

Компрессия усиления – это общая характеристика усилителя, использу-
емая для определения области перехода между линейным и нелинейным 
участками его рабочей характеристики.Точка, где отклонение реальной 
характеристики усилителя от идеальной (линейной) составляет 1 дБ, назы-
вается точкой компрессии на -1 дБ.

Выполняя свипирование по мощности с помощью векторного анализатора 
цепей, можно контролировать зависимость значения точки компрессии 
-1 дБ от уровня мощности на входе. На рис. 13 показано уменьшение 
коэффициента усиления немодулированного сигнала (на неизменяемой 
частоте) при увеличении мощности на входе (рис. 13).

При определении характеристик усилителей важно контролировать уровни 
входной и выходной мощности, чтобы обеспечить работу усилителя в соответ-
ствующем диапазоне мощности. Для измерения точки компрессии усиления
 -1 дБ или для преобразования АМ-ФМ необходимо более точно измерять
 уровни мощности тестируемого устройства. Реализованные в анализаторе 
E5072A методы калибровки мощности полезны при измерениях компрессии 
усиления, для которых требуется высокая точность абсолютного измерения 
мощности.

Диапазон свипирования по мощности должен быть достаточно велик для 
перевода усилителя из области линейного усиления в область компрес-
сии. Обычно выходной мощности анализатора E5072A достаточно для такого 
перехода. Если выходной мощности анализатора E5072A недостаточно 
для перехода усилителя из линейной области в область компрессии, то 
для ее увеличения можно использовать внешний усилитель.

Компрессия усиления оценивается на основе «двухмерного» измерения, 
состоящего свипирования по мощности и свипирования по частоте. При 
свипировании по частоте определяют точку первого появления компре-
ссии. Для анализатора E5072A компания Keysight предлагает Мастер 
измерения параметров усилителей, который поддерживает свипирующее 
измерение компрессии усиления. Подробная информация приведена в 
приложении B «Мастер измерения параметров усилителей».

Рис. 13. Измерение компрессии усиления.
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в рекомендациях по применению 
«Измерения высокой мощности с 
помощью анализатора E5072A», 
номер документа 5990-8005EN..
(http://cp.literature.keysight.com/
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Рис. 14. Измерение преобразования АМ-ФМ.
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Преобразование АМ-ФМ

Измерения преобразования АМ-ФМ полезны для оценки нелинейного 
поведения усилителей. Преобразование АМ-ФМ позволяет оценить 
нежелательные сдвиги фаз, появляющиеся при любых изменениях 
амплитуды в системе. Это преобразование измеряется с помощью свипи-
рования по мощности, выполняемого векторным анализатором цепей. 
Результирующие данные отображаются в виде зависимости комплекс-
ного коэффициента передачи в прямом направлении (S

21
) от мощности 

на входе ТУ (рис. 14). Изменение фазы и амплитуды можно легко измерять
 с помощью функций маркеров векторного анализатора цепей.

Ниже приведена последовательность измерения компрессии усиления 
усилителя и преобразования АМ-ФМ с помощью анализтора  E5072A. 
Мощность на входе и выходе ТУ контролируется через абсолютные 
измерения, одновременно выполняемые с помощью внутренних
приемников анализатора E5072A. Схема измерений не отличается от 
схемы, приведенной на рис. 8.
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Шаг 1 Настройка параметров тестового сигнала

Перед калибровкой и измерениями следует ввести параметры тестового 
сигнала, такие как частота немодулированного сигнала, полоса фильтра 
ПЧ (IFBW) и число точек (NOP). Для измерения выбрано свипирование 
по мощности. Трассы 1, 2, 3 и 4 соответственно предназначены для 
измерения компрессии усиления, преобразования АМ-ФМ, уровня мощ-
ности на входе и уровня выходной мощности. Мощность на входе ТУ 
контролируется через абсолютные измерения с помощью приемника 
R1 анализатора E5072A, выходная мощность – через измерения с 
помощью приемника B. Если в качестве трассы измерения используется 
«B (1)» (абсолютное значение на входе приемника В при выборе порта 1 
в качестве источника), то уровень выходной мощности тестируемого 
устройства (в дБм) можно контролировать после калибровки приемника. 
Уровень входной мощности можно контролировать с помощью «R1 (1)».

[Sweep Setup] > Sweep Type > Power Sweep
[Sweep Setup] > Power > CW Freq (например, 1 ГГц)
[Start] (например, -15 дБм)
[Start] (например, +5 дБм)
[Display] > Num Trace (4)
[Display] > Allocate Trace (x4)
Активировать трассу 1 и нажать [Meas] > S21, [Format] > Log Mag
Активировать трассу 2 и нажать [Meas] > S21, [Format] > Phase
Активировать трассу 3 и нажать [Meas] > Absolute > R1 (1)
Активировать трассу 4 и нажать [Meas] > Absolute > B (1) 

Шаг 2 Калибровка мощности

Калибровка с подключенным датчиком мощности выполняется 
для определения точного уровня мощности из порта 1 в плоскости 
калибровки (вход ТУ) (рис. 9).

[Cal] > Power Calibration > Select Port (1)
[Cal] > Power Calibration > Tolerance (например, 0,05 дБ)
[Cal] > Power Calibration > Max Iteration (например, 10)

Шаг 3 Калибровка приемника

Калибровка приемника необходима для выполнения точных абсолютных 
измерений. Между портами 1 и 2 включают калибровочную меру «сквозное 
соединение», после чего выполняют калибровку приемника R1 и приемника
 B. Если в качестве трассы измерения выбрано абсолютное измерение 
каждого приемника, то после калибровки приемника отображается уровень
 входной или выходной мощности тестируемого устройства (рис. 10).

[Cal] > Receiver Calibration > Select Receiver > R1 & B
[Cal] > Receiver Calibration > Source Port (1)
[Cal] > Receiver Calibration > Power Offset (0 дБ)
[Cal] > Receiver Calibration > Calibrate

Шаг 4 Калибровка с использованием калибровочных мер

Калибровка с использованием калибровочных мер выполняется при 
нажатии кнопки [Cal]. (рис. 11).
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Шаг 5 Выравнивание уровня по приемнику

Функция выравнивания уровня по приемнику используется для 
получения требуемого уровня мощности в плоскости калибровки. 
Свипирование выполняется в каждой точке данных тестового сигнала, 
отклонение от требуемого уровня мощности используется для коррек-
ции уровня мощности источника. Если для выравнивания уровня выбран 
приемник R1, то уровень входной мощности тестируемого устройства 
регулируется в соответствии с заданным значением отклонения или 
свипирование по мощности выполняется заданное число раз.
[Sweep Setup] > Power > Receiver Leveling > Port 1 > Receiver > R1
[Sweep Setup] > Power > Receiver Leveling > Port 1 > Tolerance 
(например, 0,1 дБ)
[Sweep Setup] > Power > Receiver Leveling > Port 1 > Max Iteration 
(например, 10)
[Sweep Setup] > Power > Receiver Leveling > Port 1 > Leveling > ON

Шаг 6 Поиск точки компрессии усиления

Маркер устанавливают на малом значении коэффициента усиления 
(S21) трассы 1. Точку компрессии усиления можно найти, запустив 
функцию поиска заданного отклонения усиления сигнала (например, -1 дБ).

Выбрать трассу 1 и нажать[Marker] > Marker 1
[Marker] > Ref Marker
[Marker Search] > Target > Target Value (например, -1 дБ)
[Marker Search] > Target > Search Target

Результаты измерения компрессии усиления и преобразования АМ-ФМ 
показаны на рис. 15. Отметим, что входная мощность ТУ регулируется с 
погрешностью 0,1 дБ при выравнивании уровня по приемнику R1.

Рис. 15. Результаты измерения компрессии усиления и преобразования АМ-ФМ
с контролируемой входной мощностью.



19

Мастер измерения параметров усилителей для анализатора E5072A, 
доступный на сайте компании Keysight, осуществляет пошаговое 
руководство измерением точки компрессии усиления путем подачи
немодулированного сигнала или свипирования по частоте. На рис. 16 
показан результат измерения компрессии усиления со свипированием 
по частоте, выполненного с помощью мастера. Значения мощности 
на входе и выходе тестируемого устройства в точке компрессии -1 
дБ измеряются в диапазоне частот свипирования и отображаются 
на экране. Подробную информацию см. в приложении B «Мастер 
измерения параметров усилителей».

Рис. 16. Пример измерения компрессии усиления со свипированием по 
частоте с использованием мастера измерения параметров усилителей.
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Рис. 17. Нелинейные искажения усилителей.

Нелинейные искажения

Нелинейные искажения характеризуют нелинейное поведение усили-
теля. Уровень гармоники определяется как разность абсолютных 
уровней мощности на основной частоте и частоте гармоники, выражен-
ная в дБн (дБ относительно несущей) для заданной входной или 
выходной мощности (рис. 17).
Информация о характеристиках гармоник необходима для множества 
приложений, так как слишком большие нелинейные искажения усилителя 
приводят к появлению помех по соседнему каналу в системах связи. 
Обычно измерения нелинейных искажений выполняют с помощью 
анализатора спектра и генератора сигналов. Анализатор цепей E5072A 
имеет режим отстройки частоты (опция 008)1, позволяющий измерять
гармоники при свипировании на разных частотах в источнике и приемнике. 
Источник работает на основной частоте, а приемники настраивают на 
требуемые гармоники. Объединение свипирования в режиме отстрой-
ки частоты и калибровки уровня мощности, например, калибровки мощ-
ности источника и калибровки приемника, позволяет быстрее и точнее 
измерять гармоники с помощью одного прибора – векторного анализатора 
цепей. Используя его для измерения нелинейных искажений вместо 
традиционной комбинации генератора сигналов и анализатора спектра,
можно измерять гармоники в масштабе реального времени путем 
подачи немодулированного сигнала или свипирования по частоте

Далее приведена пошаговая инструкция по измерению нелинейных 
искажений усилителей с помощью анализатора E5072A. Мощность на 
основной частоте измеряется в канале 1, мощность на частотах второй 
и третьей гармоник – в каналах 2 и 3 соответственно. В качестве источника
используется порт 1 анализатора E5072A, настроенный на основную
частоту для всех каналов. Приемник В порта 2 измеряет выходную
мощность ТУ на основной частоте и частотах гармоник.Дополнительный 
внешний аттенюатор на порте 2 используется для защиты приемника 
В от повреждения или для предотвращения компрессии.

Шаг 1 Настройка параметров тестового сигнала
Шаг 2 Калибровка мощности и калибровка приемника в диапазоне
     частот гармоник
Шаг 3 Калибровка мощности в диапазоне основной частоты
Шаг 4 Измерение гармоник

На шаге 2 приемник калибруется с помощью откалиброванного по 
мощности источника, чтобы можно было выполнять абсолютные изме-
рения во всех каналах. При такой калибровке используется диапазон 
частот гармоник. На шаге 3 мощность источника калибруется в диа-
пазоне основной частоты, чтобы точно определять уровень мощности 
на входе тестируемого устройства при измерении гармоник.
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1. Подробная информация приведена 
в Руководстве по конфигурации 
E5072A, номер документа 5990-8001EN.  
(http://cp.literature.keysight.com/
litweb/pdf/5990-8001EN.pdf)
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Шаг 1 Настройка параметров тестового сигнала

Параметры тестового сигнала, такие как частота, полосу фильтра ПЧ 
(IFBW) и число точек (NOP), необходимо ввести для каналов 1, 2 и 3.

(1) Настроить канал 1 на основную частоту
Параметры тестового сигнала, такие как частота, полоса фильтра 
ПЧ (IFBW) или уровень мощности источника, вводятся в канал 
1. Для трассы измерения выбирается абсолютное измерение с 
использованием приемника В. На экране представлены три канала.

 [Meas] > Absolute > B (1)
 [Start] (например, 1,2 ГГц)
 [Stop] (например, 1,5 ГГц)
 [Avg] > IF Bandwidth (например, 1 кГц)
 [Sweep Setup] > Points (например, 51) 
 [Sweep Setup] > Power > Power (например, 0 дБм)
 [Display] > Allocate Channel (x3)

2. Настроить канал 2 на вторую гармонику.
После выбора канала 2 в него вводятся те же параметры тестового 
сигнала, что и в канал 1. Включается режим отстройки частоты 
(FOM) и выполняется настройка источника и приемника в диапазоне 
частоты второй гармоники (например, от 2,4 до 3 ГГц).
 [Sweep Setup] > Frequency Offset > Port 1 > Multiplier (2)
 [Sweep Setup] > Frequency Offset > Port 2 > Multiplier (2)
 [Sweep Setup] > Frequency Offset > Frequency Offset (Вкл)

3. Настроить канал 3 на третью гармонику
После выбора канала 3 в него вводятся те же параметры тестового 
сигнала, что и в канал 1 или 2. Включается режим FOM и выполняется 
настройка источника и приемника в диапазоне частоты третьей 
гармоники (например, от 3,6 до 4,5 ГГц).

 [Sweep Setup] > Frequency Offset > Port 1 > Multiplier (3)
 [Sweep Setup] > Frequency Offset > Port 2 > Multiplier (3)
 [Sweep Setup] > Frequency Offset > Frequency Offset (Вкл)



22

Шаг 2 Калибровка мощности и калибровка приемника в 
диапазоне частот гармоник

1. Выполнить калибровку мощности
Калибровку мощности необходимо выполнить перед калибровкой 
приемника, чтобы точно определить характеристики приемников 
анализатора E5072A, используемых для абсолютных измерений. 
Датчик мощности соединен с портом 1 анализатора E5072A,
калибровка мощности осуществляется на основной частоте f

1
 в 

канале 1, частоте второй гармоники f
2
 в канале 2 и частоте третьей 

гармоники f
3
 в канале 3 (рис. 18).

 [Cal] > Power Calibration > Tolerance (например, 0,05 дБ)
 [Cal] > Power Calibration > Max Iteration (например, 10)
 [Cal] > Power Calibration > Take Cal Sweep

Рис. 18. Схема для калибровки мощности в диапазоне частот гармоник.

f1

f2

f3

Датчик мощности (например, 
Keysight серии U2000), подклю-
ченный к анализатору E5072A

Кан. 1

Кан. 2

Кан. 3

Порт 1 Порт 2
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2. Выполнить калибровку приемника
После подключения калибровочной меры «сквозное соединение» 
между портами 1 и 2 выполняется калибровка для абсолютных 
измерений с использованием приемника В для всех каналов. 
Приемник B калибруется в диапазоне основной частоты в канале 1,
в диапазоне второй гармоники в канале 2 и в диапазоне третьей 
гармоники в канале 3 (рис. 19).
 [Cal] > Receiver Calibration > Select Receiver > B
 [Cal] > Receiver Calibration > Calibrate

Рис. 19. Схема калибровки приемника в диапазоне частот гармоник.

B

Калибровочная мера «сквозное соединение»

Кан. 1: f1
Кан. 2: f2
Кан. 3: f3

Кан. 1: f1
Кан. 2: f2
Кан. 3: f3

Аттенюатор
(дополнительный)

Порт 1 Порт 2



24

Рис. 20. Схема калибровки мощности в диапазоне основной частоты.

Датчик мощности

ФНЧ
(дополнит.)

Кан. 1: f1
Кан. 2: 
Кан. 3: f1

f1

Рвх.

Порт 1 Порт 2

Шаг 3 Калибровка мощности в диапазоне основной частоты

Источник анализатора E5072A генерирует собственные гармоники, 
уровень которых обычно меньше 25 дБн при 5 дБм1. Для точного 
измерения гармоник источника требуется их фильтрация. ФНЧ необхо-
димо устанавливать в тракте источника порта 1, чтобы уменьшить 
ошибку измерения, связанную с наличием гармоник источника 
анализатора E5072A.
Цель калибровки мощности – получение точного уровня мощности 
в плоскости калибровки после ФНЧ в диапазоне основной частоты 
для всех каналов. При выборе 1 в качестве множителя для всех 
трех каналов, частота источника (порт 1) устанавливается равной 
основной частоте (рис. 20).

[Sweep Setup] > Frequency Offset > Port 1 > Multiplier (1)
[Cal] > Power Calibration > Take Cal Sweep

1. Подробная информация 
приведена в Техническом 
описании анализатора E5072A, 
номер документа 5990-8002EN.
(http://cp.literature.Keysight.com/
litweb/pdf/5990-8002EN.pdf)
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Шаг 4 Измерение гармоник

Тестируемое устройство подключают к анализатору E5072A и измеряют
гармоники для трех каналов анализатора (рис. 21). На рис. 22 приведены 
результаты измерений гармоник усилителя со свипированием по частоте. 
Мощность на основной частоте контролируется на основеабсолютного 
измерения в канале 1, мощность второй и третьей гармоник – 
соответственно в каналах 2 и 3.

Рис. 21. Схема измерения гармоник с помощью анализатора E5072A.

Рис. 22. Результаты измерения гармоник усилителя со свипированием по частоте.

B

 

Кан. 1: f1
Кан. 2: f2
Кан. 3: f3

Кан. 1: f1
Кан. 2: f1
Кан. 3: f1

ТУ
Аттенюатор

(дополнительный)

Порт 1 Порт 2

ФНЧ
(дополнит.)

Р
вх.

Основная частота (от 1,2 до 1,5 ГГц)
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Рис. 23. Результаты измерений гармоник усилителя со свипированием 
по частоте, выполненных с помощью мастера измерения параметров 
усилителей.

Мастер измерения параметров усилителей для анализатора E5072A 
выдает пошаговые инструкции для измерения гармоник со свипиро-
ванием по частоте. Результаты измерения гармоник усилителя со сви-
пированием по частоте, выполненные с помощью этого мастера, приве-
дены на рис. 23. С помощью мастера можно контролировать уровень 
мощности на основной частоте и вплоть до пятой гармоники (в дБм), а 
также гармоники относительно несущей (в дБн). Подробную информа-
цию см. в приложении B «Мастер измерения параметров усилителей».
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Импульсные измерения

Некоторые силовые устройства не предназначены для непрерывной 
работы. Например, усилители мощности GSM, используемые в сотовых 
телефонах, оптимизированы для эффективной работы в импульсном 
режиме, но не могут правильно работать с немодулированным сигналом. 
В схемах других усилителей мощности возможен тепловой пробой, если
их тестировать непрерывным немодулированным ВЧ-сигналом с требу-
емым уровнем амплитуды. Таким образом, для точного определения 
S-параметров необходимы импульсные ВЧ-измерения. Современные 
векторные анализаторы цепей имеют функцию запуска для таких
измерений. Векторный анализатор цепей используется для получения 
характеристик ВЧ-компонентов при работе и с немодулированными, 
и с импульсными сигналами.
Схема импульсных ВЧ измерений усилителя с помощью анализатора 
E5072A показана на рис. 24. Импульсный ВЧ сигнал, например, от импуль-
сного генератора Agilent 81150A, используется как внешний сигнал 
запуска измерений в анализаторе E5072A. Сигнал запуска должен быть
синхронизирован с ВЧ импульсом, управляющим импульсным модуля-
тором, например, полупроводниковым реле в тракте сигнала. Импульсно-
модулированный ВЧ-сигнал подается на тестируемое устройство, а 
анализатор E5072A захватывает ВЧ-сигналы, поскольку его запуск 
синхронизирован с их подачей. Минимальная длительность импульса
для импульсных измерений с помощью анализатора E5072A составляет 
около 5 мкс при полосе ПЧ 500 кГц.

Рис. 24. Типовая схема импульсных ВЧ измерений с помощью анализатора 
E5072A.

Keysight 81150A Keysight E5072A
Анализатор цепей 

Вх. опорн. 10 МГц

Вых. опорн
сигнала

Порт 1 Порт 2
Вых. запуска 1 Вых. 1

Плоскость калибровки

ВЧ вх. ВЧ вых

Вход внешнего
запуска

Импульсный модулятор

Управляющее напряжение

Генератор импульсов
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Рис. 25. Временная диаграмма импульсных ВЧ измерений с помощью 
анализатора E5072A.

На рис. 25 показана типовая временная диаграмма для импульсных 
измерений. Взятие выборок или сбор данных анализатор E5072A 
должен выполнять в течение ВЧ импульса, поэтому для выполнения 
измерений анализатором в течение нужного интервала времени 
используется внешний запуск. Важно помнить, что, в отличие от изме-
рений, выполняемых непосредственно в анализаторе E5072A, при измере-
ниях с внешним запуском появляется задержка Td, см. рис. 25. Это 
означает, что анализатор E5072A необходимо запускать перед подачей
ВЧ-импульса от генератора. Отметим также, что в анализаторе E5072AN 
такие параметры, как частота, полоса ПЧ или уровень мощности 
устанавливаются в течение определенного времени. Типичное время 
задержки анализатора E5072A составляет 12,3 мкс.

Td Ts Ta Td

 

 

Задержка

ВЧ сигнал
ВКЛ .

ВЧ сигнал
ВКЛ .

ВЧ сигнал
ВКЛ .

ВЧ сигнал
ВКЛ

Период

К-т заполн. (%)

Длит. импульса

81150A
Выход запуска 1

81150A Выход 1
(импульсный 

ВЧ сигнал)

E5072A 
Вход внешнего 

запуска

E5072A
Сбор данных

Характеристики E5072A:

Td= 12,3 ± 0,1 мкс (тип.)
Ts = 5 мкс (при полосе ПЧ 500 кГц)
Ta = 10 мкс (мин.)
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Рис. 26. Схема импульсных ВЧ-измерений с выравниванием уровня по 
приемнику в анализаторе E5072A.

R1
B

Порт 1 Порт 2
Аттенюатоp
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Характеристики многих активных устройств в импульсном режиме, 
такие как компрессия и искажения, обычно зависят от уровня мощности 
на входе. Неточно установленная мощность тестового сигнала может 
привести к значительным ошибкам измерения, поэтому важно ис-
пользовать соответствующие методики точной регулировки мощности 
тестового сигнала. Для импульсных измерений с использованием 
анализатора E5072A рекомендуется применять методику калибровки 
уровня мощности, например, выравнивание уровня по приемнику.
Ниже приведена типовая последовательность выполнения 
импульсных измерений с помощью анализатора E5072A. Входную и 
выходную мощность тестируемого устройства в импульсном режиме 
контролируют путем абсолютных измерений с помощью анализатора 
E5072A. Выходной сигнал импульсного модулятора измеряется прием-
ником R1, а температурный уход параметров модулятора компенсируется 
за счет выравнивания уровня по приемнику в анализаторе E5072A, 
чтобы точно устанавливать уровень мощности на входе тестируемого 
устройства. Для контроля выходной мощности тестируемого устройства 
выполняются абсолютные измерения с помощью приемника B. Схема 
измерений с использованием анализатора E5072A показана на рис. 26.
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Шаг 1 Настройка импульсного генератора

В генераторе Keysight 81150A устанавливаются длительность, период и 
уровень импульсов. Также в генераторе с высокой точностью задается 
задержка запуска. Импульсные сигналы подаются на импульсный модулятор 
в тракте сигнала и на вход внешнего запуска анализатора E5072A.

Шаг 2 Настройка параметров тестового сигнала

Параметры тестового сигнала – частота, полоса фильтра ПЧ (IFBW) и 
число точек (NOP) – вводятся в анализаторе E5072A перед калибровкой 
и измерениями. Полоса ПЧ должна быть достаточной для сбора данных 
при использовании коротких измерительных импульсов. Минимальная 
длительность импульса для анализатора E5072A равна 5 мкс при 
полосе ПЧ 500 кГц.
[Avg] > IF Bandwidth (например, 500 кГц)

Шаг 3 Калибровка мощности

Калибровка мощности с помощью датчика мощности, подсоединенного в 
плоскости калибровки, позволяет точно определять уровень мощности 
на входе тестируемого устройства за счет компенсации потерь, вносимых 
импульсным модулятором или ответвителем в тракте сигнала. Если для 
калибровки используется датчик средней мощности, то коэффициент 
заполнения сигналов импульсного генератора должен быть равен 100 %.

[Cal] > Power Calibration > Select Port (1)
[Cal] > Power Calibration > Tolerance (например, 0,05 дБ)
[Cal] > Power Calibration > Max Iteration (например, 10)
[Cal] > Power Calibration > Take Cal Sweep

Шаг 4 Калибровка приемника
Калибровка приемника необходима для выполнения точных абсолютных 
измерений. Между портами 1 и 2 подключают калибровочную меру
«сквозное соединение», после чего выполняют калибровку приемника 
R1 и приемника B. Когда в качестве трассы измерения выбрано абсолютное
 измерение для каждого приемника, уровень входной или выходной 
мощности тестируемого устройства отображается после калибровки 
приемника.
[Cal] > Receiver Calibration > Select Receiver > R1 & B
[Cal] > Receiver Calibration > Source Port (1)
[Cal] > Receiver Calibration > Power Offset (0 дБ)
[Cal] > Receiver Calibration > Calibrate

Шаг 5 Калибровка

Для калибровки S-параметров в импульсном режиме следует 
выбрать запуск по внешнему сигналу. Изменение времени задержки 
между приемом сигнала запуска и сбором данных для получения 
точной временной диаграммы можно минимизировать, нажав 
программную клавишу [Low Latency] (Малая задержка).

[Trigger] > Trigger Source > External
[Trigger] > Trigger Event > On Point
[Trigger] > Low Latency (ВКЛ)
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Для выполнения синхронизированных калиброванных измерений по 
внешнему сигналу запуска выполняется калибровка с использованием 
механических калибровочных мер. Чтобы выполнить калибровку с 
помощью импульсных ВЧ сигналов, следует нажать кнопку [Cal]. Заметьте,
что коэффициент заполнения импульсных сигналов на импульсном генера-
торе, подающим импульсные ВЧ-сигналы на модулятор и анализатор 
E5072A, необходимо устанавливать перед выполнением калибровочных 
измерений.

Шаг 6 Выравнивание уровня по приемнику

Для компенсации температурного ухода параметров модулятора 
выполняется выравнивание уровня по приемнику. Мощность источника 
анализатора E5072A регулируется для получения точного требуемого 
уровня мощности на входе тестируемого устройства.
[Sweep Setup] > Power > Receiver Leveling > Port 1 > Receiver > R1
[Sweep Setup] > Power > Receiver Leveling > Port 1 > Tolerance 
(например, 0,1 дБ)
[Sweep Setup] > Power > Receiver Leveling > Port 1 > Max Iteration 
(например, 10)
[Sweep Setup] > Power > Receiver Leveling > Port 1 > Leveling (ВКЛ)

Шаг 7 Импульсные измерения

Пример результатов импульсных измерений коэффициента усиления 
ВЧ-усилителя приведенна рис. 27. Результаты измерений с внутренним 
запуском представлены скачкообразно изменяющейся трассой (трасса 
памяти), указывающей на то, что анализатор не может захватить данные.
Результаты измерений с внешним запуском (трасса данных) показывают 
точную частотную характеристику тестируемого устройства в импульсном 
режиме

Рис. 27. Результаты импульсных ВЧ-измерений.
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На рис. 28 сравниваются результаты измерений при включенном (трасса
данных) и выключенном (трасса памяти) выравнивании уровня по приемнику 
R1. При включении выравнивания уровня по приемнику, входная мощность 
(Pвх.) в импульсном режиме на входе тестируемого устройства регулиру-
ется в пределах допустимого диапазона. Это позволяет повысить точность
результатов измерений, особенно при работе тестируемого устройства 
в нелинейной области. Кратковременный уход параметров импульсного 
модулятора исключен, поэтому выравнивание уровня по приемнику полезно 
для оценки активных устройств, характеристики которых зависят от 
мощности или нелинейного режима работы таких устройств.

Рис. 28. Выравнивание уровня по приемнику позволяет повысить точность 
импульсных измерений усилителя в нелинейной области.

Современный векторный анализатор цепей, такой как E5072A, 
обладает множеством полезных функций для точного определения 
характеристик усилителей, благодаря чему можно значительно 
упростить схему измерений и сделать их менее трудоемкими.

Выводы
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Следует учитывать, что внутренние компоненты векторного анализатора 
цепей рассчитаны на определенную мощность. При высоких уровнях
мощности возможно повреждение внутренних компонентов анализатора, 
что приведет к дорогостоящему ремонту. Поэтому важно понимать, как
работает анализатор, и знать предельную допустимую мощность каждого
компонента сигнального тракта. Блок-схема анализатора E5072A 
показана на рис. 29. Каждый тестовый порт (порт 1 и порт 2) анализатора 
E5072A связан с шестью разъемами SMA на передней панели для 
прямого доступа к приемнику. Уровень повреждения и уровень компрес-
сии указаны в таблице 1. Убедитесь, что эти уровни не превышены, и 
при необходимости добавьте внешние аттенюаторы или ответвители 
к системе тестирования. Уровень входной мощности должен быть по 
меньшей мере на 3 дБ ниже уровня повреждения порта на анализаторе 
E5072A (а лучше, чтобы на 6 дБ ниже).

Приложение A. 
Предельно допустимая мощность

Разъем Уровень повреждения
ВЧ тракта (тип.)

Уровень повреждения
тракта пост. тока (тип.)

Уровень компрессии на 0,1 дБ
(наиб. вероятн. значение)

Tестовые порты 1 и 2 +26 дБм ± 35 В пост.тока

+6 дБм (от 30 до 300 кГц)
+16 дБм (от 300 кГц до 2 ГГц)
+14 дБм (от 2 до 6 ГГц)
+10 дБм (от 6 до 8,5 ГГц)

CPLR ARM +15 дБм 0 В пост.тока -

RCVR A IN, RCVR B IN +15 дБм ± 16 В пост.тока
–15 дБм (от 30 до 300 кГц)
–10 дБм (от 300 кГц до 8,5 ГГц)

SOURCE OUT (Port 1 & 2) +26 дБм 0 В пост.тока -

CPLR THRU (Port 1 & 2) +26 дБм ± 35 В пост.тока -

REF 1 /2 SOURCE OUT +15 дБм 0 В пост.тока -

RCVR R1 IN, RCVR R2 IN +15 дБм ± 16 В пост.тока
-15 дБм (от 30 до 300 кГц)
-10 дБм (от 300 кГц до 8,5 ГГц)

Рис. 29. Блок схема анализатора E5072A.
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REF 1 REF 2

Порт 1 Порт 2

Источник

Однополюсный переключатель
на 2 направления

Полупроводниковый
аттенюатор (65 дБ)

Механический
ступенчатый 
аттенюатор 

(60 дБ, 
шаг 10 дБ)

Механический
ступенчатый 
аттенюатор 

(60 дБ, 
шаг 10 дБ)

Цепь
смещения

Цепь
смещения

Табл. 1. Уровень повреждения и уровень компрессии тестовых портов.
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Рис. 30. Мастер измерения параметров усилителей для анализатора E5072A.

Для автоматизации тестирования в анализаторе цепей серии ENA
можно создавать макросы с помощью встроенного языка программиро-
вания VBA от компании Microsoft. Благодаря этому вы можете без 
дополнительных расходов создать собственный интерфейс для опти-
мизации среды испытаний и добавления автоматических функций. 
На сайте компании Agilent имеется множество примеров программ на 
языке VBA для анализаторов серии ENA (www.keysight.com/find/enavba), на 
основе которых можно создавать собственную библиотеку программ

Мастер измерения параметров усилителей для анализатора E5072A 
предназначен для измерений основных параметров усилителей (рис. 
30). Эта программа поддерживает следующие измерения усилителей 
с помощью анализатора E5072A:

S-параметры / K-фактор
Измерение нелинейных искажений со свипированием по частоте
Компрессия усиления и преобразование АМ-ФМ (немодулированный сигнал)
Компрессия усиления со свипированием по частоте

Мастер руководит настройкой параметров и калибровкой, что 
позволяет минимизировать время подготовки к измерениям. Мастер 
также поддерживает измерения усилителя высокой мощности, 
выполняемые с помощью анализатора E5072A и внешнего усилителя.

Приложение B.
Мастер измерения параметров усилителей
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В табл. 2 сравниваются возможности анализаторов цепей Keysight E5071C 
и E5072A серии ENA. По ним видно, что анализатор E5072A наиболее 
полно подходит для определения характеристик ВЧ усилителей.

Приложение C.
Сравнение анализаторов E5071C и E5072A

Характеристики / Функции E5071C, 2 порта, ВЧ опции (опц.
24x, 26x, 28x)

E5072A

Конфигурируемая схема измерений 
(прямой доступ к приемнику)

Нет Да (стандартная функция)

Без развязки по питанию 
(с аттенюаторами источника)

Нет Да

Макс. выходная мощность +10 дБм (до 5 ГГц)
+16 дБм (специф., до 3 ГГц)
+20 дБм (SPD1, от 300 кГц до 1 ГГц)

Калибровка мощности Да
Да (более высокая точность при допустимых 
значениях и максимальном числе итераций)

Калибровка приемника Да
Да (с четырьмя независимыми 
приемниками)

Контроль приемника Нет Да
Нелинейные искажения Да (с опцией FOM) Да (с опцией FOM)
Импульсные ВЧ-измерения Да (большая длительность импульса) Да (большая длительность импульса)

Amplifier measurement wizard Да
Да (поддерживается измерение 
усилителей высокой мощности)

Мастер измерения параметров усилителей Да Да
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Табл. 2. Сравнение анализаторов цепей Agilent E5071C и E5072A серии ENA.

1. SPD – наиболее вероятное значение. Оно не гарантируется.
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